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This document describes the EDGE CAD editor, the context and the concepts

behind its conception, as well as its use.
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Chapter 1. Introduction
EDGE — for ExtendeD Gdml Editor — is an easy-to-use GDML-based CAD editor. It provides a

powerful and flexible CSG model fully compliant with the GDML format, used by numerous particle-

matter interactions analysis tools based on the Geant4 library [https://geant4.web.cern.ch/geant4/].

EDGE provides also various import/export capabilities from/to B-Rep based CAD formats.

EDGE has been developed by Artenum in the frame of its internal R&D activities and is available

through several of its commercial services offers, like SpaceSuite [https://www.space-suite.com].

About GDML

Based on XML syntax, the Geometry Definition Markup Language (GDML)

[http://gdml.web.cern.ch/GDML/] is the reference language used to describe geometrical models (i.e.

CAD models) for radiation modelling tools like Geant4 [https://geant4.web.cern.ch/geant4/], ESA/GRAS

[https://space-env.esa.int/software-tools/gras/] or SPIS-IC [https://www.spis.org]. GDML is based on a rich

CSG approach and can be used to create complex and realistic geometrical systems to be used for

various purposes.

As an XML-based language, it can be fairly well read by humans and it is quite simple to parse it.

However, one of its limits is that it is difficult to visualise what a GDML file is going to produce just

by looking at it in a tailored sense, i.e. as a 3D geometrical system. Although some viewers or

editors exist, only a few of them are publicly available, and they are not user-friendly or incomplete.

Moreover, most GDML editors so far cannot handle the depth hierarchy used in GDML.

Therefore, Artenum decided to develop a GDML editor based on the Keridwen IME

[http://www.keridwen.org]. Its aim is to propose a simple-to-use, cross-platform editor with good

capacities of visualization.

Main functionalities

EDGE can either create or load a complete GDML model. In both cases, the user can modify the

properties of all the shapes or add new shapes. Moreover, shapes also have position and

orientation properties that allow placing them correctly. To facilitate the work for the user, position

and orientation can be applied to several objects at the same time. EDGE handles complex

hierarchies with several levels of depth.

EDGE also allows editing and attributing material properties to each shape individually. At any

time, the user can see the results of his work thanks to the real-time 3D.

After editing his file, the user can save the result back to GDML but he can also export it to the B-
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Rep .geo format (the file format of Gmsh).

Supported formats

Import

EDGE support natively the GDML format in reading and writing, but is also able to import

numerous B-Rep CAD formats like Gmsh’s geo or STEP-AP 203/214 and tessellated solids in STL

or UNV files. These import/export capabilities open interoperability bridges with other CAD tools

and multi-physics simulation software.

Figure 1. Example of imported STEP-AP model inside EDGE

Export and CSG-to-B-Rep decomposition

EDGE is able to convert GDML models into an equivalent Gmsh’s geo file, fully compliant with

tailored applications like SPIS. This conversion is not done by tessellation but by a proper CSG to

B-Rep decomposition with the view in Gmsh (on the left) of a model initially defined in EDGE (on

the right).

Figure 2. GDML model defined in EDGE
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Figure 3. B-Rep decomposition visualized in Gmsh

Caution and limit of warranties

The present document is intended to be a simple User Manual (UM) to help the user to use EDGE

in basic mode to create CAD modelling. This document does not attempt to provide to the future

EDGE user the whole expertise and knowledge needed to create a correct CAD modelling. The

final confidence in the relevance and accuracy of the CAD model depends on the user expertise

and remains his responsibility.

FOR THIS REASON, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT

PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING, THE

COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS"

WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT

NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A

PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF

THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME

THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.


For an improved handling of the key concept addressed by EDGE or for any

further information, please contact the SpaceSuite team [https://www.space-

suite.com/contact].
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Chapter 2. Quick Start

2.1. Starting Edge

The application as well as the present User Manual can be downloaded from the SpaceSuite

[https://www.space-suite.com] Web page.


Currently, EDGE can be used on most 64bits Linux platforms, Microsoft

Windows-7-8-10 64bits and MacOS 10.10.5 and higher (with Intel chips).

Once downloaded, the zip file containing the EDGE snapshot has to be extracted on the machine

where it will be used on to ensure that the software is executable.


On Windows systems, the native unzipping method may encounter issues when

unzipping EDGE. You may want to use third-party application to avoid issues. The

unzip has been successfully tested with the 7Zip [https://www.7-zip.org/] application.

2.1.1. Linux

Depending on your precise Linux distribution, double-clicking on the Edge.sh file may launch the

application correctly (see below for more details on Gnome environments).

To start the application, it is also possible to open a terminal and just execute ./Edge.sh in the

application directory. It is then possible to indicate launching options, see the Command-line

launching options paragraph below.



On recent Linux distributions with Gnome, double-clicking on the Edge.sh file

displays the content of the file instead of launching it. You may modify this

behaviour by going to the file manager preferences and changing the way

executable files are handled. On newer Gnome environments, you can only do

Right-click › Run as program.

2.1.2. MacOS

To start the application, there are two possibilities:

• Use the Terminal application: go to the application folder and execute the Edge.sh file.

• Launch without terminal:
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- right-click on the Edge.sh file and select Open with › Others…

- in the window, in the lower part, in [ Activate ], select [ All the applications ] and check the

[ Always open with ] checkbox

- select the "Terminal" application (usually found in the "Utility" folder)

- the system may show a warning that the developper could not be identified, select the

"Open" button



Anti-malware software solution

On newer macOS systems, the system anti-malware security may block the

launching of the application. In this case, please follow these instructions for the

first launch of the application:

• Before trying to launch the application, please deactivate temporarily the anti-

malware

- Open the "Terminal" application

- Enter the following command sudo spctl --master-enable

- Your password is requested (beware the entered characters are hidden as

a security measure)

• Now follow the instructions above to launch the application

• Then, re-activate the anti-malware protection:

- In the terminal window, type the command sudo spctl --master-enable

- Your password may be requested again

2.1.3. Windows

Double-clinking on the Edge.bat will launch the application.

To use more advanced launching options, you can open a command invite, go the EDGE folder

and type Edge.bat. Options can be provided, see the Command-line launching options paragraph

below.

For compatibility with all Windows systems, it is not possible to launch several EDGE at the same

time on Windows. If you want to be able to launch several instances, you need to edit the

EDGE.bat file and test if this function works on your system.

Once the file is opened in your favourite text editor look for the following part:
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set NOW=1

and replace it with the following content:

set NOW=%date:~-4,4%%date:~-7,2%%date:~-10,2%%FormatedTime:~-11,2%%FormatedTime:~-
8,2%%FormatedTime:~-5,2%%FormatedTime:~-2,2%

Save the modification and relaunch EDGE. If EDGE starts, you will be able to launch several

instances of your software. If not, please revert the modification to be able to use EDGE: your

system does not support launching several instances by using the automatic date computation

mechanism.

2.1.4. Command-line launching options

It is possible to use options to launch EDGE. The options can be added (up to one at a time) after

the launching command. To know all the available options, the option –h can be used (such as

./Edge.sh -h or Edge.bat -h).

• -f path/to/gdml/file.gdml : this option enables loading the given file directly in the application

at start-up.

2.2. EDGE Main Window

The GUI of EDGE is intuitive and based on the concept of perspectives, where the modelled

system can be viewed and handled from different approach or points of view, like the edition of the

geometrical model, the definition of material properties or the assignment of these materials to

their correct geometric shape.

Some elements of the graphical interface are common for all perspectives:

• Main Menu (on the top) corresponds to main control menu of the application.

• General Toolbar (below) presents shortcut buttons to open and save (on the left) a file and

also allows switching from a perspective to another (on the right). This toolbar also grants

access to the preferences panel.

Main elements of EDGE window (here in the geometry perspective)

 … 
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2.2.1. Main menu

File menu

The File menu allows opening and saving GDML files and also various import and export options.

An option also permits opening recent files. Finally the exit option enables leaving the application.

Please note that EDGE can only load one file at a time. When opening a GDML file, if there are

unsaved modifications, the application will propose to save this work before replacing it by the new

opened file.

In its trial version, EDGE does not allow exporting or saving to GDML.



EDGE tries to load all files, even if there are inconsistencies.

For example, if a file contains two solids with the same name, EDGE will only

consider the last element with this name and inform about this issue and the

chosen resolution.

Tools menu

The Tools menu offers various tools and shortcuts. From here, you can access the preferences

panel presented in preferences. The console log is displaying various messages from the
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application such as errors and warnings.

With this menu, it is also possible to apply corrective patch to EDGE or install new feature plugin.

To do so, click on the correct item and a file choose will appear and asks where the patch/plugin is

located. Once installed, it is recommended to restart the application.

This menu also offers access to various tools and model computation operations which are

described in more details in model operations.

Other menus

The Views menu allows switching from one of the perspectives presented earlier to another.

The Help menu is useful to access this user manual directly from within the application. This menu

also offers the about screen, resuming information about the software and installed

plugins/patches.

2.3. Preferences

The Preferences dialog box allows the setting of the applications options.

At the first launch of the application, the Preferences dialog box is shown and enables the user to

change the default parameters right away.


For each option, a [ Reset to default ] button allows switching back to the initial

value.

2.3.1. 3D viewer preferences

Figure 4. 3D viewer preferences panel

EDGE 2.6.0 User manual

© Artenum SARL 9 / 65



The first tab display options about the 3D viewer of the application:

Default world opacity

Sets the default opacity used when creating the world shape. Indeed, a colour is automatically

chosen for every new shape and this setting will choose the opacity for this colour. The value

0.0 is fully transparent while the value 1.0 is fully opaque. Please note that this setting will not

change the opacity of the world already displayed in the 3D view.

Default shape opacity

Sets the default opacity used when adding a new shape to the 3D view. For more details, see

the previous preference about the world shape.

Display sizes in the 3D view

This option activates an additional widget when selecting elements in the 3D view: the size (in

meters) are directly shown. It is disabled by default for better clarity in the 3D view.

Show tessellated edges

This option activates the highlight of the edges of tessellated shapes inside the 3D view.

2.3.2. GDML default material preferences

Figure 5. GDML material preferences panel

The second tab — shown above — offers options concerning the default GDML materials used in

the application. Indeed, when a new shape is created in EDGE, a default material is assigned to it

that can be changed later on in the Material Assignment perspective. Here, it is possible to select

which material will be assigned to the world element and to other elements. The selection can be

performed from within the EDGE default materials list and the Geant4 default materials list.
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2.3.3. GDML writer preferences

Figure 6. GDML writer preferences panel

The third tab — shown above — sets parameters for the GDML writer:

Write default values

If this option is selected, the values for optional fields will be written even if they equal to the

default value — it is the case for example for the position and orientation (0 is the default value);

Write default units

If this option is selected, the units will always be specified inside the GDML file even if they

equal to the GDML default units (mm for lengths and radians for angles);

Write non-used user-defined materials

If this option is selected and that the user has defined materials which are not assigned to a

geometric shape, those materials will be stored in the GDML file anyway;

Save chosen colours to GDML file

If this option is selected, the colours chosen in the Geometry panel will be saved to the GDML

file using the <auxiliary> tag, and then when loading the file the colours will be the same. Be

careful, the content of the <auxiliary> tag is not interpreted by the Geant4 numerical kernel.

This tag is usually properly treated by the client code as explained in the GDML user manual.

Validation mechanism in GDML file

Choose the reference to the GDML file validator (.xsd) defined in the GDML file.

online The validation process requires an internet connection when the file in other tools is

loaded).
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local The validation is made locally with a validator file embedded on the local computer.

The saved GDML file can only be used on this computer as long as the software is

not moved.

none No reference to a GDML file validator is written, then no validation will be processed

when the GDML file will be used by other tools.

2.3.4. General preferences

Figure 7. General preferences panel

The fourth tab offers more general usability preferences, as shown above:

Distance unit for new shapes

this setting enables to define the default distance unit when adding a new shape (for distance

values and the position). It avoids to change the unit each time you create a new shape.

Angle unit for new shapes

same effect as the previous one but applies to angle units (for angles values and orientation)

Maximum number of recent files

this option controls the number of recent files stored by EDGE and accessible in the File ›
Open recent… menu.

Enable drag’n’drop

Enables the possibility to move the elements in the Shapes tree using drag and drop gesture

with the mouse. It facilitates the modification of the hierarchy — to avoid unwanted modifications

— this option is disabled by default.
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Display [ Add new shape ] labels

Display shortcut labels in the shapes tree of the Geometry Edition perspective. These labels

help to gain time to add new shape but this option is disabled by default to gain cleanliness.

2.3.5. System preferences

Figure 8. System preferences panel

The last tab sets preferences for the system, as shown above. The user can choose:

Application cache directory

By clicking on the “Browse” button, the user can choose the path where the application stores

its temporary files. It may be useful to change this setting if you do not have write access to your

temporary folder (by default EDGE uses the operating system default temporary folder).

Maximum allocated memory

The user can choose the value and unit (Mo or Go) of the available memory for EDGE. It can be

useful to increase this value when loading very big files, without exceeding the system

maximum capabilities.
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Chapter 3. Perspectives

3.1. Geometry edition

The Geometry perspective is the main perspective of EDGE since it allows the creation and the

edition of geometrical elements.

3.1.1. Geometry perspective

It is the main perspective of EDGE displayed by default at the launching. It has three main panels

to edit the geometry, as shown below.

• Top left: Shapes Tree panel, to visualise and edit the list of geometric shapes;

• Bottom left: Properties panel, to edit the properties of the currently selected shape;

• Right: 3D Viewer panel, present only for the geometrical edition and material assignment

perspectives, provides a 3D view of the modelled system.

These panels, as well as the 3D View panel, can be moved, detached or maximized at the user’s

liking using the buttons on their top right corner.

Figure 9. Default arrangement of the geometry perspective
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Shapes tree

The Shapes tree lists all the shapes currently defined in the geometrical model and displayed in

the 3D scene. It also shows the hierarchy of the shapes. The shape(s) currently selected is (are)

highlighted in the 3D view on the right with a red box. It is also possible to move one geometry

element and all its children elements to another logical location in the geometry tree. This feature is

available only when the "enable drag’n’drop" preference has been enabled in the preferences.

On the right of each shape, a click on the coloured box opens a dialog that allows changing the

colour of the shape in the 3D view. It is also possible to change the transparency of the selected

element in this dialog box, as shown below. A checkbox on the right controls the visibility of the

object in the 3D view.

Figure 10. Colour chooser dialog

On top of the tree, buttons are used to control the shapes. The four buttons on the left side allow

adding, duplicating, removing shapes and/or creating Boolean operations.

Button Action Available

Opens a dialog box to add a new shape to the tree Always

Duplicates the selected shape(s) At least 1 shape selected

Deletes all the shapes currently selected in the tree At least 1 shape selected

Creates Boolean operation using selected shapes At least 2 shape selected

The two buttons on the right side allow performing actions on the currently selected shape(s).
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Button Action

Opens a dialog to apply transformations to selected elements

Offers the possibility to use a clipping filter, see below

The clipping button triggers the apparition of a dialog box allowing the user to set the parameters of

the clipping filter, as shown below. This filter performs a cut in the geometry to view more precisely

the inner geometry of the modelled system. The clipping is set with the coordinates of a centre

point and a normal direction. It will keep the geometric representation of the selected element in

the half-space defined by this point and the normal. To get a more interactive setting, you can

select the [ Display 3D control widget ] option that will display an interactive control in the 3D

view to change the clipping. These 3D controls of the filter are materialised by a sphere

(representing the centre of the clipping operation) and an axis with two arrows (representing the

normal direction).

Figure 11. Clipping settings panel (right) and result inside 3D view (left)


The clipping filter is just a visualisation tool, it will not change the geometry

definition.

Properties panel

This panel shows the properties of the shape currently selected in the Shapes tree. It shows

properties only if there is one — and only one — shape selected. Depending on the shape

selected, the properties displayed change accordingly.

The user can thus define the dimensions of the shape. For each shape, parameters vary and
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explanatory schemes are presented in the Supported shapes schematics annex. These pictures

are also available in the software by clicking on the [ Help ] button.

This panel shows also fields to choose the position and orientation of the object and the unit of

measure. The unit for parameters, positions and rotations can be changed and an automatic

conversion of values is proposed. The default units are millimetres (mm) for lengths and radians

(rad) for angles, but it can be changed in the preferences.

The orientation parameter represents the orientation of the shape around its centre of mass: each

angle (also known as Euler angle) represents an orientation around the X, Y and Z axis

respectively.

Those rotations are applied in the following order: first the Z orientation, then the Y one and finally

the X rotation.

Note on the Thickness parameter and Boolean operations

Some elements — such as boxes, ellipsoids, orbs, parallelepipeds and trapezoids — have

an additional useful parameter inside EDGE (not present in GDML) called thickness. If a

shape has a thickness defined (different from 0), then the export of this shape will be done

using Boolean operations (a subtraction between the outer element and the inner element).

It allows the user to gain time for this kind of operations.

This kind of shape can be very useful during the definition of radiation analysis. The user

shall be aware that this thickness value is not a GDML parameter, which means that setting

this parameter to a value different from zero will result, in the GDML file, to the

corresponding Boolean operation. The little warning sign next to the name of this parameter

is present to remind the user of this.

If an EDGE file containing a shape with a defined thickness (different from 0) has been

saved and is then loaded again, the user must note that the concerned shape will be

displayed as Boolean operations. It means that when the user will click on the corresponding

shape, it will be displayed as a Boolean operation and the user will have to [ Deconstruct ]

the Boolean operation to edit its elements parameters.

3D View

The 3D view is showing in real-time the product of the GDML model. It is possible to interact with

the view using the mouse to control it:
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 Action

Left click (hold) and movement: rotate the scene

Wheel (hold) and movement: translate the scene

Right click (hold) and movement: zoom

Or, with the keyboard:


Action

R resets the view and shows all the shapes of the scene

I to zoom in

O to zoom out

W displays the shapes as wireframes

S displays the shapes as solid

The up/down/left/right arrows rotate the scene.

The buttons at the top of the view also facilitate its handling (from left to right):

Button Action

resets the view and shows all the shapes of the scene (“R” key shortcut)

aligns the view along +X axis

aligns the view along -X axis

aligns the view along +Y axis

aligns the view along --Y axis

aligns the view along +Z axis

aligns the view along -Z axis

On top of the 3D view, a drop-down menu allows the user to choose a model operation to launch.

These operations are also available through the Tools menu.
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On the bottom of the 3D view, an information bar displays useful information about the current

selection: the number of selected elements as well as the size and the position of the bounding box

— the red box around selected elements. It is possible to click on the number of selected elements

to display a list of the currently selected elements.

3.1.2. Available geometric shapes

EDGE handles several primitive geometric shapes as shown below. Other kind of shapes are also

supported and presented in next section.

Figure 12. All available shapes inside EDGE

Available shape Non-handled shape

 Box  Polycone

 Cone Segment  Generic Polycone

 Ellipsoid  Polyhedron

 Elliptical Cone  Generic Polyhedron

 Elliptical Tube  Torus Segment

 Orb  Tube with Hyperbolic Profile

 Paraboloid  Cut Tube

 Parallelepiped  Twisted Box

 Sphere  Twisted Trapezoid

 Trapezoid  Twisted General Trapezoid

 General Trapezoid  Twisted Tube Segment

 Tube Segment  Extruded Solid
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Available shape Non-handled shape

 Arbitrary Trapezoid (Arb8)

Inside EDGE, a  button is available to show detailed schematics presenting the various

parameters for each shapes. These schematics can also be found in Supported shapes

schematics annex

3.1.3. Other available shapes

EDGE is able to handle other types of shapes other than the plain CSG primitives presented in

previous section.

Tessellated Solid

Solids with complex geometries can be constructed by importing tessellated surfaces, including

initially B-Rep based models. Those tessellated surfaces are converted into an equivalent GDML

tessellated solid object.


Please note that the imported tessellated surface must imperatively be a closed

surface. EDGE displays a warning message to the user if it is not the case.

EDGE 2.6.0 User manual

© Artenum SARL 20 / 65



Figure 13. Example of an imported tessellated solid

Assemblies

In EDGE, the user has the possibility to handle “assembly” elements. Those elements are grouping

several shapes without being attached to a geometric shape.

Assemblies are part of the GDML format but may not always be supported by numerical kernels.


It is possible to remove all assemblies from the CAD by using the Reorganise

model tool.

GDML file

EDGE also allows importing all the geometry concepts from another GDML file and including them

as a child of the currently selected element. This option can be very useful if users want to check

the position of a spec ic subsystem (defined in the imported GDML file) in the whole system (main

GDML file).
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Figure 14. Example of import of GDML file

3.1.4. Geometry edition

Creating and adding a new shape

The user has first to create a “world” shape that will include all subsequent shapes. The position (0,

0, 0) corresponds to the barycentre of this world shape. Once this is done, it is possible to start the

construction of the desired object.



Note about the "World" elemnt

Even if technically GDML allows creating a world smaller than the final object, it is

not recommended.

The world shape typically corresponds to the computational domain of numerous

of simulation kernels using GDML files in input. And most of these tools will not

work properly nor give relevant results the world shape does not encapsulate all

other elements.

The relevant definition of the world shape remains on the responsibility of the

user and with respect to the final targeted application.

Clicking on the  button (or the [ Add the world shape ]/[ Add new shape ] links if enabled

in Preferences) opens the New Shape Wizard.

On the left panel of the dialog box, all the available shapes are represented. A click on a shape

selects it and shows its properties on the right panel. Properties requirement varies with the

different shapes, but for each one the Name, Unit Configuration, Position and Rotation can be
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filled-up. All the properties can also be edited via the Properties Panel.

Figure 15. New shape dialog for a box

If the tree is empty, the first new shape will become the world shape. After that, each new shape

will be added to the tree as a child of the current selected element. If no element is selected, the

new element will be added as a child of the world shape. This feature makes possible the creation

of objects with a complex hierarchy of objects.

The new shape dialog box displays all the available import options which may vary depending on

the installed plug-ins. Basic ones are the B-Rep format files import (.geo, .msh, .stl, .unv), or the

GDML file import.

Transforming several elements

Position and orientation can be directly edited in the properties panel. However, as it is not

convenient to use this feature on each element to move, a multi-transformation tool has been
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implemented, accessible via the  icon of the Shapes tree. Clicking on this button opens the

transformation dialog for the selected elements in the tree.

Figure 16. Multi-element transformation dialog

This dialog box allows setting the translation and rotation to apply to the elements. These

transformations can replace the current position and orientation properties of the objects or be

added to any existing placement information.

For example, for an object at a (1, 1, 1) position, a transformation of (2, 0, 0) with [ Add

transformation to existing ] will displace the object to (3, 1, 1), when [ Replace

transformations ] will displace it to (2, 0, 0).

Creating Boolean operation

Using the create Boolean operation button , it is possible to create Union, Intersection and

Subtraction directly in EDGE.

In order to create a Boolean operation, it is necessary to select two elements and click on the

button. The dialog shown below will appear and let you choose a name for the Boolean operation,

which is element is the first and which one is the second and finally the type of operation.
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 Please note that the order is important for subtraction and intersection only.

It is also possible to create directly a multi-union that groups more than two elements directly.

3.2. Material definition

The aim of this perspective is to define materials that will be attributed later to a geometric shape.

The Material definition perspective has no 3D view but is composed of three main panels, as

shown below.

• Top left: Materials list, the list of user-defined materials;

• Bottom left (collapsed by default): Available Geant4 Materials, the list of available Geant4

default materials;

• Right: Material editor, panel to edit the currently selected material.

Figure 17. EDGE material definition view

EDGE 2.6.0 User manual

© Artenum SARL 25 / 65



3.2.1. About GDML materials

In GDML format, materials are defined by their isotopic and stoichiometry compositions.

Materials can be defined by a single “atom”, a composition of elements or fractions of elements.

These elements can be simple “atom” or represent an isotropic distribution. The schema below

presents different examples of material defined using the GDML formalism.

Figure 18. Material definition in GDML

Figure 19. Examples of different ways of defining materials in GDML

3.2.2. Materials list

Creating a material is performed by clicking on the  button.


Saving custom materials

A new material which is not attributed to a geometrical shape in the Materials

assignment perspective will not be saved inside the generated .gdml file when
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saving the file in EDGE.

In order to save materials which are not attributed inside the .gdml file, it is

necessary to activate the "write non-used user-defined materials" preference

which is disabled by default.

In order to edit a material, a click on an element in the list updates the material editor with the

current material where it can be edited.

It is possible to duplicate a material by clicking on the  button. Those new materials are added

at the end of the materials list and their names are incremented in order to not confuse them with

the initial materials.

Deleting a selected material is performed by clicking on the  button.

By clicking on the  button, it is possible to import materials from another GDML file or from a

GDML materials XML file. In the case of a GDML file, this mechanism will import all materials

written inside the GDML file. Reminder: in order to write all materials in a GDML file, even the

ones, which are not assigned to a geometry shape, it is necessary to activate the "write non-used

user-defined materials" preference which is disabled by default.

Finally, clicking on the  button exports the materials into a GDML material file (.xml). All the

user-defined materials will be exported.

3.2.3. Geant4 materials

Available Geant4 materials for the material assignment are displayed in the Geant4 materials

panel, on the bottom left of the perspective.

When clicking on the title, the pane is expanded to show the list of materials and their associated

density. By clicking on the header of the column, it is possible to sort the materials.
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Figure 20. Table of available Geant4 materials and their associated density

3.2.4. Material editor

The material editor is separated in two main parts: the first one on the top is the same for every

material allows defining the name, the density and other properties of the material. Below, a

section enables to define the composition of the material and changes depending on the type of

chosen material.

Screenshot below shows the editor for a simple “atom” material. On the top, it is possible to fill in

the material name, the density in g/cm3 and optional properties before choosing the type of

material.
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Figure 21. Material editor for an "atom" material showing the optional properties

General optional material properties can be set by clicking on [ Show optional properties ] and

are:

• The choice of the atomic number Z (when atom is not selected);

• The formula;

• The state (liquid, solid, gaseous);

• The absorption length (AL);

• The mean excitation energy (MEE);

• The pressure (P);

• The radiation length (RL);

• The temperature (T).

The user can then choose a material type.
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Figure 22. Material editor for a composition of element (here water)

Screenshot above shows the material editor for a composition of elements.

These elements are similar to atom shown previously but can have additional meta-data attached

to them using the [ Show optional properties ] button. The number of each element is chosen on

the left with the “n” field. It is easy to add and remove elements just by clicking on the  button

and  respectively.

It is possible to define material with isotopes instead of elements. In this case each element is

made of fractions of isotopes.

Also, it is possible to define a material with fractions (percentage between 0 and 1) of

elements/isotopes instead of compositions.

To apply the modifications, it is necessary to click on the [ Apply modifications ] button.

3.3. Material assignment

The aim of this perspective is to apply the materials defined in the material definition perspective to

the geometry defined in the geometry edition perspective. Thus, this view only makes sense when

at least one shape has been defined in the geometry perspective.
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The materials assignment perspective has the same 3D view as the geometry one.

• Top left: Material assignment tree, tree of the geometric shapes and the currently applied

material;

• Bottom left: Material assignment selector, panel to select the material for the currently

selected shape(s);

• Right: 3D viewer, 3D viewer highlighting the currently selected shape(s).

Figure 23. EDGE material assignment view

3.3.1. Materials assignment tree

This panel contains a tree-table with two columns.

The first column (on the left) shows the tree of geometry shapes created in the Geometry edition

perspective.

The second column (on the right) indicates the material attributed to each corresponding geometry

shape. By double-clicking on the right column, it is possible to directly change material assignment

without going inside the editor.
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

Default materials

By default, the Geant4 material 'G4_Galactic' (i.e. space environment) is

attributed to the geometry shape representing the world. All other geometry

shapes created are, by default, composed of 'G4_Aluminium'.

This behaviour can be changed in the Preferences.

3.3.2. Material selection

The Material selection panel allows the user to select the material to attribute to a geometry shape,

defined in the Geometry edition perspective.

Figure 24. Material selection panel

When at least one geometry shape is selected in the Materials assignment tree, the panel displays

several choices of material for the user to choose in the list below:

Pre-defined materials:

Predefined Geant4 materials that can be directly used to assign the material.

Custom materials:

This option is only available when there is at least one custom material defined in the material

definition perspective.

The choice updates the content of the drop-down list with either the pre-defined materials or the

custom ones.


It is possible to filter the drop-down list but typing letters on the keyboard. For

instance, typing a  +  l  +  u  will filter the list with materials having "alu" in the name

(not takiing into account the case).

When the chosen material is selected in the drop down list, the modification must be saved by

clicking on the [ Apply ] button. The [ Cancel ] button reset the material assigment to the initial

value.
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3.4. GDML File perspective

EDGE provides a rich text-editor to complete the capabilities of the GUI and let the user freely edit

and extend the generated GDML file currently loaded in EDGE.

The perspective is dedicated to this editor shown below.

Figure 25. EDGE GDML file perspective

A rich text-editor shows how the GDML file would be generated on disk. The content of the editor is

updated each time the perspective is opened.

It is possible to modify the GDML file directly by editing the generated content. Once modification

performed, it is possible to reload the file into EDGE (to see the modifications in the 3D view for

example) using the [ Save & Update EDGE ] button but it is also possible to save the produced

content to somewhere else on the disk by using the [ Save as… ] button.



Be aware, that when reloading your modification into EDGE, it will be

reinterpreted by the software and if you switch back to the GDML file perspective,

its content will be re-generated from EDGE data-model and thus may have a

different syntax but will represent the same system.

This editor provides a syntactic colorization and completion, this last one available by typing the

ctrl+space key combination.


This perspective is disabled in trial mode of EDGE and you need the full version

of EDGE to use it.
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Chapter 4. Model operations
The user can perform operations on the created CAD model thanks to the [ Model operations ]

drop-down menu or inside the Tools menu. The list of available operations may be subject to

changes depending on installed additional modules.

The following operations are always available in EDGE.

4.1. GDML File validity check

This operation checks the syntax validity of a GDML file against the GDML file format

specifications. It is possible to check the current file (if saved beforehand) or any file from the

system.

It is possible to select the wanted GDML file version used to check the XML validity of the file. The [

Offline mode ] uses copies of the GDML schema stored inside EDGE folder instead of the ones

stored on the GDML server (at http://cern.ch/2001/Schemas/GDML).

Figure 26. GDML file validity check tool

4.2. Check for overlaps

This operation allows the user to check if there are no overlaps inside the geometry, meaning that

there are no shapes overlapping each other.

It is possible to choose if "touching" shapes should be considered as overlapping or not. To launch

the calculation, the user can click on the  button. The  button allows the user to stop the

calculation at any time.
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Figure 27. Overlaps calculation results (indicates that the LeftPanelCenter and RightPanelCenter elements

are overlapping)

4.3. Compute volume

This operation allows the user to obtain the volume of the geometry. The computed value is an

approximation of the real volume value based on 3D meshing of the shapes. As for the previous

operation, the calculation is launch with the  button and can be stopped with the  button.

Figure 28. Volume computation results



Computation function limited capabilities

Computation of volume (and thus mass) may fail over complex systems or

indicate a volume equal to zero (like on the screenshot above for the world

shape). This is an indicative tool to check consistency with real system.

It is advised to not use this tool on complex systems.

4.4. Reorganise model

This operation allows the user to check the consistency of the hierarchy of the model. Indeed, to
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get proper radiations results, elements that are included in other ones (geometrically) should be

placed as child of the geometrical shapes they are in. This tool computes the real hierarchy,

displays the results to the user and proposes to modify the model accordingly.

Figure 29. Example of hierarchy reorganisation results



Removal of logical assemblies

This tool will remove all assemblies from the model as they do not have a physical

representation that can be used to sort elements.

As some code may not handle well assemblies, this tool can be used to

automatically remove these assemblies.
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Chapter 5. Additional modules

5.1. SSAM



Access to additional modules is provided through additional plugins and may

require an additional license and/or depends on your EDGE license. Contact the

SpaceSuite team [https://www.space-suite.com/contact/] for more information.

The installation procedure is detailed in the Tools menu description.

To launch SSAM, select SSAM in the model operation list.

5.1.1. About SSAM

SSAM is used to perform a sector shielding analysis on the CAD model in EDGE. Using a ray-

tracing technique, SSAM will perform, from a target point of view, an evaluation of the shielding

thickness in all directions of a selected angular sector. The target can typically be a sensitive

device on which the user wants to evaluate radiations effect. Taking into account the nature of

attributed materials, the geometrical thickness is converted into aluminium effective one. For this

reason, please note that the geometry must be properly defined and materials assigned to it in

order to use SSAM.

5.1.2. Input parameters

SSAM needs the following input parameters as illustrated below:

Position

Where to perform sector shielding analysis (x, y, z and length unit);

Sphere sectors

The number of sphere sectors around this location to divide the space in theta(θ) and phi(φ)

directions — with theta varying between 0 and 2π and phi between 0 and π;

Emitted rays

The total number of rays to launch for the sector shielding analysis.
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Figure 30. Inputs parameters for SSAM

Click on the  button to launch SSAM.

From the defined position, the selected number of rays is launched in all directions (using an

isotropic distribution). SSAM computes the distance in each material density type crossed by the

ray and calculates the equivalent thickness of Aluminium defined by a density of 2.699 g/cm^3.

All these results are then summarised for each sphere sector computing the minimal, mean and

maximal of the equivalent thickness of Aluminium.


SSAM also check if there is no overlap in the geometry to avoid problems during

the calculations. If it detects overlaps, the computation will stop with a message

explaining it.

5.1.3. Results view

SSAM results are displayed after all the rays are launched.

There are several areas to display SSAM results as illustrated below.
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Figure 31. SSAM results

Left

Lists the 3D results elements and allow to change their visibility, transparency and colours by

clicking on the corresponding checkboxes and coloured buttons. By default, the modelling

geometry is displayed in transparency and in black colour. The position of the target is

represented by a red sphere. Please note, in some cases, this sphere can be small compared

to the global geometry size and a zooming might be needed to see it.

Centre

3D view of the different results computed with SSAM.

Right

Table with 4 columns and several rows. Each row is the result of a sphere sector defined by a

division in theta and phi directions described by the input parameters. The columns are

respectively the mean, the minimum, the maximum and the standard deviation of the mean

values of the equivalent thickness of aluminium in this sphere sector. All these values are

expressed in metre. The standard deviation is computed with the following formula, with

nb_{rays} the total ray launched in the sphere sector, t_{i} the equivalent thickness of the ray

i, t_{mean} the mean of all equivalent thicknesses in the sphere sectors:

deviation=\sqrt{\frac{\sum_{i=1}^{nb_{rays}} (t_i - t_{mean})^2}{nb_{rays} - 1}}

Top right

The contextual menu bar provides several possibilities to display the selected results in the 3D

view or as plots, export them into CSV format files or to compute the dose received by the

target.
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5.1.4. 3D results

The "Show in 3D …" menu allow to display results in the 3D view. The selected result appears in

the 3D view and is listed in the control panel. The following 3D representations are available:

• The minimum, mean or maximum of the equivalent aluminium thickness for each sphere sector.

More information about each sphere sector can be obtained by clicking on each sphere sector

item in the list of 3D items;

Figure 32. 3D sphere sectors results or "hedgehog view"

• The average sphere considering the mean of the equivalent aluminium thickness for all rays

launched by SSAM. The details regarding this sphere, like the diameter can be displayed by

clicking on the item in the list of 3D items.

The information bar at the bottom of the 3D view gives the size of the selected element

bounding box enabling to quickly access the size of the sphere;

• The number of interceptions for each face of the geometry. This 3D result can be used to check

if enough rays have been launched to provide a statistic good enough: if a face has zero

interceptions, it indicates that not enough rays has been launched to intercept this face.

When selecting this results in the list of 3D items, a scalar bar appears helping assess the

value represented by each colour;
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Figure 33. Number of intercepting rays for each face

• The minimum, mean or maximum hollow sphere sectors of equivalent aluminium thickness.

Users must set the inner radius of the hollow sphere, and the space between each sphere

sector. The details of each hollow sphere sector are available by clicking on each sphere sector

item in the list of 3D results.

Figure 34. 3D hollow sphere sectors results

• A coloured sphere where each colour represents the value of the equivalent thickness of

Aluminium in metre.

When selecting this results in the list of 3D items, a scalar bar appears helping assess the

value represented by each colour.
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Figure 35. Sphere sector aluminium equivalent thickness mapped on a coloured sphere

5.1.5. Plot results

The "Plot…" menu enables to display plots of meaningful results into new pop-ups windows.

The following results are available:

• y = f(x) chart type where the minimum, the mean and the maximum of the equivalent

thickness of Aluminium in metre for each sphere sector is displayed.
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Figure 36. Minimum, mean and maximum equivalent thickness of Aluminium in metre for each sphere

sector

• y = f(x) chart type with the mean of the equivalent thickness of Aluminium in metre and its

standard deviation are displayed for each sphere sector.

Figure 37. The mean of the equivalent thickness of Aluminium and its standard deviation in metre for

each sphere sector
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• A 2D Map showing the angular repartition of the equivalent thickness of Aluminium for each

sphere sector.

Figure 38. Angular repartition of the equivalent thickness of aluminium in metre for each sphere sector

5.1.6. Export options

The "Export…" menu enables to save the following results on the disk:

• The equivalent thicknesses of Aluminium in metre to a CSV file;

• An equivalent sphere with a radius equal to the average of the equivalent thicknesses of

Aluminium of all rays used for SSAM.

This sphere is exported to a GDML file;

• The number of rays which intercepted each face of the geometry in a VTK file;

• The hollow sphere sectors using the minimum, the mean or the maximum of the equivalent

thickness of Aluminium of all sphere sectors.

The hollow sphere sectors are exported to a GDML file.

Users must set the radius of the hollow sphere, and the space between each sphere sector to

avoid cross contacts and overlapping between sectors to respect GEANT4 constraints.
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5.1.7. Dose computation

The "Dose computation" menu, opens a new popup, as illustrated below, to compute the

cumulative dose based on the previous computed aluminium equivalent thicknesses. Users must

beforehand set the tabulated function defining the evolution of the cumulative dose versus the

depth of a material, using external software, models or experimental data. The user may, for

instance, use the Shildose2 model, as provided in the frame of the ESA/BIRA/Spenvis online

application.

Figure 39. Dose computation view

It is possible to set it manually directly in the editor or to load a csv file with two columns separated
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by a comma. The first column defines the depth and the second one the dose. An example of such

file is provided in the CSV file for dose example annex and also in the data directory of EDGE.

Additionally, it is also necessary to set the unit of the two axes: Gray or Rad for the dose and g/cm²

or millimetre of a material with a specific density for the depth. If the selected unit is g/cm², then it is

not necessary to set the density because the results do not depend on the density of the material.

Finally, on the right part of the editor, the points of the tabulated function are displayed.

When the inputs parameters for the dose computation are set, users can click on the 

button. Both the equivalent thickness of Aluminium of each sphere sector and the dose versus

depth tabulated function are used to compute the deposited dose using the following formula,

where \Omega_i is the surface of the sphere sector i, D(T_i) is the dose for the equivalent

thickness of Aluminium of the sphere sector i:

Total \ dose = \frac{1}{4\pi} \sum_{i}^{sectors} \Omega_i D(T_i)

Then a new popup appears with the results of the cumulative dose. The results are computed

considering the minimum, the mean and the maximum of the equivalent thickness of Aluminium for

all sphere sectors.

Users can choose to save these results in a dedicated file by clicking on the  button.



Limits of the sector shielding analysis approach

The sector shielding analysis approach implies the particle transport through the

matter be averaged as straight lines from the sources to the target, without

scattering, diffusion nor secondary particles emissions.

This may constitute a severe assumption is some cases, like for electrons

diffusion. Moreover, the position of the punctual target, as defined in SSAM, may

deeply impact the effectively viewed shielding, i.e. effect of point-of-view, and the

total cumulated dose of a larger sensitive component, with a spatial extension, be

significantly differ.

For these reasons, results computed with a sector shielding analysis should be

considered with care and remain of the full responsibility of the end user and his

expertise.

5.2. DeCADe
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

Access to additional modules is provided through additional plugins and may

require an additional license and/or depends on your EDGE license. Contact the

SpaceSuite team [https://www.space-suite.com/contact/] for more information.

The installation procedure is detailed in the Tools menu description.

DeCADE, for Detesselator and Extended CAD importer, is an EDGE-plug-in providing extended

STEP-AP format capabilities and a set of geometry simplification and clean-up features to adapted

the imported geometry to radiations analysis.

5.2.1. Smart STEP-AP importer

As any importer, the Smart STEP-AP importer is available in the File › Import menu or inside the

"Add new shape" dialog.

The extended STEP-AP importer allows to:

• Import STEP element by element (i.e. shell by shell) by selecting the [ Separate elements ]

check-box

• Sort elements by size when imported in EDGE to facilitate the removal of small elements by

checking the [ Ascending sort by size ] check-box.

Figure 40. STEP-AP import dialog preview

The screenshot below presents an example of imported STEP-AP file (a Raspberry Pi card) inside

EDGE using the DeCADe smart importer.
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Figure 41. Example of imported STEP-AP file in EDGE

5.2.2. Detessellation operation

After importing a STEP-AP, or any other meshed/b-rep based format, the geometry is made of

tessellated elements that cannot be edited and induce more CPU cost when performing Geant4

analysis.

DeCADe offers a function called "Detessellator" that enables to convert tessellated elements into

CSG primitives fully compatible with GDML. To use this function, after selecting the elements who

want to detessellate, click on the  button in the tool-bar on top of the list of shapes.

A new dialog appears to select a few options:

[ Separate non-continuous shapes ]

This function will detect in the tessellated element if there are non-continuous surfaces that

represents two different shapes. Then it will create a shape per different continuous surface. If

not selected, the tessellated element is considered as only one element. It is recommended to

keep this option active.

[ Automatic shape detection ]

The algorithm detects automatically which primitive is closer to the selected element between

Boxes, Cones and Spheres. If not selected, you must choose by which primitive the tessellated

shape will be approximated. The available shapes are then Box, Cone, Cylinder, Ellipsoid and

Sphere.

The screenshot below presents an example of detessellation, here on an embedded computer

mother board from an initial STEP-AP file in a cubesat. The left view shows the initial import as
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triangulated surfaces. The right-side view shows the equivalent pure CSG / GDML model. All

components have been automatically detected and converted by the detesselator.

Figure 42. Example of detessellation: tessellated elements (left) versus GDML primitives obtained with

DeCADe (right)

In most of the usual cases, canonical shapes can be automatically detected, sized and located or,

for the most complex case, can manually be pre-identified by the user through the GUI and

automatically sized, located and oriented automatically by the application.

5.3. Internal Charging Meshing



Access to additional modules is provided through additional plugins and may

require an additional license and/or depends on your EDGE license. Contact the

SpaceSuite team [https://www.space-suite.com/contact/] for more information.

The installation procedure is detailed in the Tools menu description.

Volume Mesh Creation for Internal Charging Analysis, in short Internal Charging Meshing, is an

EDGE-plug-in developed to widely facilitate the creation of scoring volume mesh used in the

SpaceSuite internal charging modelling chain.

First, this modelling chain needs the CAD of the system from a GDML file created, for example,

with EDGE. This file is then used by MoORa [https://www.space-suite.com/moora/] to compute the

interactions between the particles coming from the space environment and the materials.

During this computation, both the deposited dose and charge are scored in a volume mesh used

later in the modelling chain as initial condition for SPIS-IC [https://www.spis.org/software/spis/] to

compute the internal charging effect in the dielectric.

The purpose of the Internal Charging Meshing EDGE plug-in is to compute this volume mesh

where both the deposited dose and charge will be computed later by MoORa.

Standing for Modelling Of Radiations, MoORA is a user-friendly and simple to use software

EDGE 2.6.0 User manual

© Artenum SARL 49 / 65

https://www.space-suite.com/contact/
https://www.space-suite.com/moora/
https://www.spis.org/software/spis/


developed by Artenum that helps modelling the radiations transport using Geant4, a Monte-Carlo

numerical kernel.

Internal Charging Meshing provides tools for GDML manipulation to: select the dielectrics we want

to study; move elements relatively to each other and merge common surfaces between elements.

Then, an easy-to-use mesh editor generates a volume mesh, which can be anisotropic depending

on the user needs.

Internal Charging Meshing starts from a GDML file used for Geant4 analysis. The hierarchy of the

GDML geometry must be consistent with the Geant4 requirements. The volume mesh to create will

be saved on the disk in a .msh Gmsh mesh file [https://gmsh.info]. The volume mesh to create is the

input CAD file for the SPIS-IC simulation. It is usually the dielectric we want to study where the

surface continuity has to be guaranteed. Finally, the Internal Charging Meshing plug-in creates a

MoORa project where the CAD model is the GDML file defined in EDGE, the particle source is a

sphere surrounding the geometry, with a cosine-law angle distribution and electrons at 1MeV and

both the deposited dose and charge will be computed on the scoring volume mesh.

The plug-in is available from the "model operations" drop down menu. If users want to create a

complete .moora project, the GDML CAD file needs to be finalized before to use the plugin.

5.3.1. Home

At the launching, the Internal Charging Meshing opens the Home perspective () of the plug-in a

new window, displaying two icons:

Only available if a geometry is present in EDGE. Choosing this option loads the current GDML

geometry, except the world element and goes to the next step.


The hierarchy of the GDML geometry must be consistent with the Geant4

requirements: a shape containing another shape must be the parent of this

shape in the data tree model.

Always available, it allows importing previously designed B-Rep geometries. Choosing this

option sends directly to the Mesh creation perspective (see Mesh creation).

 Imported .geo file cannot be modified inside the application.
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5.3.2. Subsystem selection

Subsystem selection perspective ( ) is dedicated to the selection of the GDML subsystem we

want to study.

Its interface is divided in tree part, as it can be seen below:

• Left bar: Perspective selector to navigate between the different perspectives;

• Left: Subsystem selection panel, detailed in the next paragraphs;

• Right: 3D Viewer provides a 3D view of the complete GDML model.

Figure 43. Subsystem selection perspective

In the subsystem selection interface, all the GDML elements are listed. This list can be expanded

() or collapsed () by clicking on the corresponding icons.

Relevant GDML elements must be selected in the subsystem selection interface. They can be

selected or unselected individually. Moreover, click on  to select all the elements, while

icon:square-o: cancels the whole selection. Selected elements are coloured in green inside the 3D

viewer.

Users need to select a sub-system with only one parent elements containing all other ones.

So, if a single Gdml element is selected, sub-system selection can be directly validated (clicking

on Validate sub-system selection ).

Otherwise, if several elements are selected without a unique selected parent, the user has

to create an external volume including all the selected shapes ([ Add external volume ]
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button). The shape of the new external created volume is necessarily a rectangular parallelepiped

and can differ from the world element defined in the standard EDGE interface. Nevertheless, it has

to be included inside the world element defined in EDGE. The default dimensions of this volume at

its creation are the minimal values to entirely contain the internal elements. This external shape

can be reshaped and repositioned using the x, y and z size and position fields visible on figure

above. The new shape is validated by clicking on [ Apply changes ].

When the external volume is well shaped, the user can pass to the next perspective by clicking on

Validate sub-system selection .

5.3.3. Put solids in contact

The objective of this step is to put in contact shapes with other shapes. It is necessary because the

GDML CAD model respects the GEANT4 numerical kernel constraints (especially shapes must not

be in contact with other shapes neither overlapping) but in SPIS-IC numerical kernel, constraints

regarding the geometry are different: the shapes which are really in contact must also be in contact

in the geometry (to allow the charge to move from one shape to another one by conductivity).

This is why, it may be necessary to put shapes from the initial GDML model in contact with other

shapes. Depending on the study, this operation is not mandatory.

The Put solids in contact perspective interface ( ) seems quite similar to the Subsystem

selection perspective, as it can be seen below. It allows to move GDML elements between each

other to put them in contact.

An element can be selected as:

A target

Single target is defined for each move. It is the motionless reference element of the put in

contact.

 The selected target is coloured in yellow in the 3D viewer.

Move shape(s)

Several move shapes can be defined simultaneously for a move.

 Move shape(s) are coloured in green in the 3D viewer.
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Figure 44. Put in contact perspective

Next, the move direction of the move shape has to be defined.

Two ways can be used to choose this direction:

• The quick definition icons [ + ] / [ - ] and [ X ] / [ Y ] / [ Z ] allow to define a move direction

parallel to one of the director vectors of the 3D geometry.

The selected direction is displayed in the field below.

• Alternatively, the move direction can be defined freely in the input fields by selecting on [

Custom ] or by directly editing the content of X/Y/Z fields.

When the target, move shapes and direction motion are correctly defined, the modification can be

applied by clicking on the [ Move shapes ] button . Previous motions can be canceled with the 

icon to go back to the initial state.



Limiting motion of GDML shapes

If the length of the motion is greater than 1 µm, a warning message is displayed.

Indeed, moving the shape is a modification regarding the GDML geometry used

by the Geant4 numerical kernel. Move shape with a distance too big will lead to

unexpected scoring Geant4 simulation results where the scoring volume mesh

and its corresponding GDML shape are in two different positions.

This warning will not be displayed for the created external volume because it is an
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empty volume with no shape defined in the GDML CAD model.

When all the desired motions have been realised, click on Validate move and generate merged

geometry . to go to the next perspective.


The put in contact tool is actually not able to merge the edges from different

GDML elements.

5.3.4. Mesh creation

The Mesh creation perspective  provides a tool to generate Gmsh mesh. This mesh may be

computed with strong anisotropy if necessary.

For the study of the effect of internal charging, the volume mesh on the dielectrics will be used to

score both the deposited dose and charge rates with Monte-Carlo simulations. Ideally, the volume

mesh would have small tetrahedra in all directions to have a good modelling of the internal

charging effects. Nevertheless, the CPU time of the Monte-Carlo simulations can be long to reach

a good statistic in all of these tetrahedra. The objective is to reach a good ratio between the size of

the tetrahedra and the CPU time which will keep internal charging results accurate enough. The

smallest the number of tetrahedra in the volume mesh is, the shortest the CPU time will be.

To minimize the number of tetrahedra in the volume mesh of the dielectric one solution is to have

small tetrahedron size in the direction where the electric field and potential will change quickly and

bigger tetrahedron size in other directions. In some situations, like high voltage dielectric card for

example, strong anisotropic volume mesh needs to be computed.
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Figure 45. Mesh creation perspective

Mesh can be generated from:

• the GDML subsystem designed in the chain detailed in the two previous sections. The

generated geometry is a Gmsh .geo file. Both surfaces in contact and volume with other volume

inside it have been "smartly" computed by creating surfaces and volumes with holes to be

consistent with the SPIS-IC numerical kernel constraints regarding the geometry;

• an external .geo file loaded by clicking on the  Import .geo file icon.

 Export … icon enables to export the geometry to a .geo v2 or v4 file.

The mesh element size is governed from the X/Y/Z anisotropy coefficients fields, where the tile size

is written in meters.

In order to generate a mesh with a sufficient resolution, an anisotropy coefficient size have to be a

fraction of the sensitive element size following the concerned direction. If an anisotropy coefficient

size is greater than the dimension of a shape, this shape will be mesh with the coarsest possible

cells.

To facilitate the choice of Anisotropy coefficient size, the 3D viewer of the mesh creation

perspective presents several functionalities.

Button Action

allows moving and turn the viewer
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Button Action

allows to select a shape of the geometry in the 3D viewer. The shape is

highlighted in the list.

drop-down menu regrouping the same icons as EDGE to align the 3D view with

the X/Y/Z axis

drop-down menu that allows to choose the transparency of all the surfaces

displays the surface of the shapes

displays the surface of the shape and the edge of the mesh

displays only the mesh edges

Surfaces displays all the surfaces of the geometry in the shape list

Physical

Surfaces

displays in the shape list the Gmsh physical surfaces where specific properties

will be applied in SPIS-IC

Volumes displays the volume of the geometry ranked by their id number in the shape list

Physical

Volumes

displays in the shape list the physical volume of the geometry ranked by their

name where will be applied in SPIS-IC specific properties (for example the

material properties)

In the shape list on the left side of the perspective, each item can be selected or unselected which

will change the visibility of the shape in the 3D view and will not impact the mesh creation.

Moreover, selecting a shape displays this dimension in the bottom of the 3D viewer. That can be

helpful to correctly choose the anisotropy coefficients.

By clicking on the colour box of each item, the colour shape of the selected item will be changed in

the 3D view according to the new selected colour.

When the field are correctly filled out, the mesh can be created by clicking on Compute mesh .

5.3.5. Mesh checking and export

The last perspective , which can be seen below, allows to check and export the GDML

subsystem and the Gmsh mesh to a MoORa Project.
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Figure 46. Checking and export interface

The 3D viewer interface of this perspective is very similar to the previous one. It allows checking

visually the mesh by modifying the 3D viewer option as it can be seen below.

Figure 47. Example of anisotropic mesh visualisation

When the check is complete the geometry and the mesh can be export by clicking on  Export to

MoORa project, or the mesh can still be modified by returning to the previous perspective .

include::mcnp.adoc[]
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Chapter 6. Annexes

6.1. Supported shapes

Note on the Thickness parameter and Boolean operations

Some elements — such as boxes, ellipsoids, orbs, parallelepipeds and trapezoids — have

an additional useful parameter inside EDGE (not present in GDML) called thickness. If a

shape has a thickness defined (different from 0), then the export of this shape will be done

using Boolean operations (a subtraction between the outer element and the inner element).

It allows the user to gain time for this kind of operations.

This kind of shape can be very useful during the definition of radiation analysis. The user

shall be aware that this thickness value is not a GDML parameter, which means that setting

this parameter to a value different from zero will result, in the GDML file, to the

corresponding Boolean operation. The little warning sign next to the name of this parameter

is present to remind the user of this.

If an EDGE file containing a shape with a defined thickness (different from 0) has been

saved and is then loaded again, the user must note that the concerned shape will be

displayed as Boolean operations. It means that when the user will click on the corresponding

shape, it will be displayed as a Boolean operation and the user will have to [ Deconstruct ]

the Boolean operation to edit its elements parameters.

6.1.1. Box parameters
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6.1.2. Cone parameters

6.1.3. Ellipsoid parameters

6.1.4. Elliptical cone parameters
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6.1.5. Elliptical tube parameters

6.1.6. Orb parameters
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6.1.7. Paraboloid parameters

6.1.8. Parallelepiped parameters

6.1.9. Sphere parameters
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6.1.10. Trapezoid parameters

6.1.11. General Trapezoid parameters
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6.1.12. Tube parameters

6.2. Example of materials

Here after is presented an example of material definition in GDML format (partial description).

<materials>
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     <!--   Examples of basic or fundamental materials -->
    <element name="videRef" formula="VACUUM" Z="1">
        <atom value="1"/>
    </element>

    <element name="aluminum" formula="Al" Z="13">
        <atom value="26.9815"/>
    </element>

    <element name="carbon" formula="C" Z="6">
        <atom value="12.0107"/>
    </element>

    <element name="Hydrogen" formula="H2" Z="1">
        <atom value="1.01"/>
    </element>

    <element name="Nitrogen" formula="N2" Z="7">
        <atom value="14.01"/>
    </element>

    <element name="Oxygen" formula="O2" Z="8">
        <atom value="16.0"/>
    </element>

     <!--   Examples of complex or composite materials -->
    <material name="Mat_ALUMINUM" formula="ALUMINUM">
        <D value ="2.7000" unit="g/cm3"/>
        <fraction n="1.0000" ref="aluminum"/>
    </material>

    <material name="Mat_Kapton" formula="Kapton">
        <D value ="1.42" unit="g/cm3"/>
        <fraction n="0.0273" ref="Hydrogen"/>
        <fraction n="0.7213" ref="carbon"/>
        <fraction n="0.0765" ref="Nitrogen"/>
        <fraction n="0.1749" ref="Oxygen"/>
    </material>
</materials>

6.3. CSV file for dose example

Here after is presented an example of csv file defining the dose in Rad versus the depth in g/cm2 in

a tabulated function for the dose computation.
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The first column is the depth and the second column is the dose.

0.01, 1800000
0.03, 1100000
0.05, 500000
0.08, 250000
0.10, 130000
0.13, 79000
0.16, 52000
0.21, 28000
0.27, 19000
0.40, 10000
0.50, 6000
0.70, 4200
0.80, 3100
1.1, 1900
1.3, 1300
1.6, 1100
1.9, 1000
2.1, 900
2.4, 800
2.7, 750
3.2, 700
3.8, 650
4.3, 600
4.9, 570
5.4, 500
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